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Downloading and installing the Keil IDE
1. Click on the following link:
https://www.keil.com/download/product/

2.

3.

Choose MDK-ARM.

[

‘[Zl Keil Product Downloads

[+]

N

€ 3] hitps//aww keil.com/download/product/ c ‘ ‘\Vv Wik

Pty

&  Products  Download

Download Products

Select a product from the list below to download the latest version.

Events Support  Videos

¥ MDK-ARM ST C51
Version 4.72a (July 2013) Version 9.52 (July 2013)

" Development environment for Cortex and ARM devices. h Development tools for all 8051 devices.
C166 =08 C251
Version 7.53 (July 2013} 3

Development tools for C166, XC166, & XC2000 MCUs.

Keil products use a License Management system - without a current license the product runs as a Lite/Evaluation edition with a few Limitations.

Version 5.55 (July 2013)
‘ Development tools for all 80251 devices.

Fill out the form and then click on the submit button, at the bottom of the page.

[TrEs

|E|ARM Wersion 4.72a Evaluation Software ... | +

€ | ] keil.com | https://www keil.com/demo/eval/arm.htm c ‘ | W ~ Wikipedia (en) P| @« B g
N

Software & Hardware Products
ARM Development Tools
C166 Development Tools
C51 Development Tools
C251 Development Tools
Debug Adapters
Evaluation Boards

Product Brochures

Newsletters

Device Database®

Device List

Compliance Testing
ISO/ANS! Compliance

Validation and Verification

Distributors
Oveniiew

ARM Software

Microcontroller Development Kit
Version 4.72a
Complete the following form to download the Keil software development tools.

Enter Your Contact Information Below

First Name. |
Last Name:
E-mail:
Company:

Address:

city-
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https://www.keil.com/download/product/

4. Click on the MDKxxX.EXE link.

5.

6.

Product Brochures

Newsletters

Device Database®

Compliance Testing
ISO/ANS| Compliance

Validation and Verification

Distributors
Overview

€« Da https://www.keil.com/demo/eval/arm.htm# ¢ Q, Search ﬂ’ E L 2 4 %‘:
Arm Development Tools MDK-ARM
C166 Development Tools MDK-ARM Version 5.24a
C51 Development Tools Version 5,24
C251 Development Tools = Review the hardware requirements before installing this software.
Debug Adapters = Note the limitations of the evaluation tools.
Evaluation Boards = Further installation instructions for MDKS

(MD5:d75f933cebcf87d0c19060362bf7686a)

To install the MDK-ARM Software...

Device List = Right-click on MDK524A.EXE and save it to your computer.
= PDF files may be opened with Acrobat Reader.
= ZIP files may be opened with PKZIP or WINZIP.

MDK524A.EXE 796,513K)
Tuesday, July 4, 2017

4 1

m

= [f you are evaluating the tools, be sure to request a quote for the full version of tr _

+

Choose Save.

-
Opening MDK524a.EXE

==

You have chosen to open:

[ MDK524a.EXE

which is: Binary File (778 MB)
from: http://az717401 vo.msecnd.net

Would you like to save this file?

Save File Cancel

Execute the downloaded file. Installing the software is straight forward; choose the Next

button in each step, until the setup finishes.
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Installing Legacy support package for ARM7
7. Open the following link and click on Legacy Support for ARM7, ARM9 & Cortex-R.

http://www2.keil.com/mdk5/legacy

/ MDK v Legacy Support x\+
() www2 keil.com/mdkS/1 egacy E1 ¢ Q, Search ﬁ' E ¥+ 4 gv: . =

ArmekeEiL

# Products Download Events Support Q, search Keil cd| |

Home / MDK Version 5 | Legacy Support I

MDK v4 Legacy Support

MDK Version 5 uses Software Packs to support a microcontroller device and to use middleware. To maintain backward
compatibility with MDK Version 4 you may install Legacy Support. This might be necessary for two reasons:

= To maintain projects created with MDK Version 4 without migrating to Software Packs.

= To use older devices that are not supported by a Device Family Pack.

Legacy support for ARM Cortex-M devices Legacy support for ARM7, ARM9 & Cortex-R

& Quick
¥ Download Legacy Support ¥ Download Legacy Support « MDK Oy
for Cortex-M Devices for ARM7, ARM9 & Cortex-R )
= Getting
Version 5.24 Version 5.24 = Middiew _
4 I LS
- 4

8. Install the downloaded file.
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http://www2.keil.com/mdk5/legacy

Creating an Assembly project in Keil
9. Open the Keil IDE by clicking on its icon on the desktop.
10. Choose New uVision Project from the Project menu.

-
p\iziond u_u-:-'ﬁl'
File Edit View I Project | Flash Debug Peripherals Tools 5SVCS Window Help
D ﬁ =l ﬂ IMew WVision Project... I : gg E .,J'.,J'E:t| @& EINTOI
: S e @ Mew Multi-Project Workspace...
Open Project...
Project
Close Project
Export
Manage
Select Device for Target...
Remaove Item
A% Options.., Alt=F7
EP @B | i1 | Clean target
: Build target Fr
Build Output
Rebuild all target files
b
Eatch Build...
. Translate... Ctrl+F7
i
F] Stop build .
-

11. Create a new folder and Name it OurFirstProject. Type the name ourFirstProject for the
project and click Save.

[ {3 Create New Project et S
GO-| | v OurFirstProject ~ | 44 || Search QurfirstProject Al

Organize - Mew folder 1= = a

¥ Favorites pi Mame Date modified Type

B Desktop

1l Downloads
'fE__.,T; Recent Places
a4 MaridiBooks
@ Music

lob

. DATASHEETS
B videos

& Google Drive sl m " b

File name: I ourFirstProject I -

Save as type: | Project Files (*.uvproj) vl

(A Hide Folders | save ||| cancel QII

Mo items match your search,




12. Select Legacy Device Database from the combo box. Then, in the Database tree, click on the
NXP and choose LPC2368. Then press OK.

When you choose the chip some general information of the chip is shown in the
Description box.

Device |
Legacy Device Databaze [no RTE] -
Vendor:  MXP
Device:  LPCZ368
Toolget:  ARM
Search: I
Description:
£1 Lpc23e2 ;I ARMTTDMI-5 based high-performance 32-bit RISC Microcontroller -
€1 LpC236e with Thumb extensions, B
£3 LpC236s 512KB on-hip Flash ROM with In-System Programming {ISP) and
€1 LPCI36s In-Application Programming (IAF). 58KE RAM, CPU clock up to 72 MHz
On-chip crystal oscillator, On-chip 4MHz RC oscillator, On-chip PLL =
£3 LPC23a7
ey —/} |Enhanced Vectored Intemupt Controller, Ethemet 10./100 MAC with DM
LPC2368 USE 2.0 Full Speed Device Controller, CAM 2.0 with two channels,
£3 Lpc237T General purpose DMA cortroller, Four UARTS, one with full modem
|interfface, Three 12C seral intefaces, Three SPI/SSP senal interffaces,
€1 LpC237s 125 interface, SD/MMC memany-card interface, 10-bit ADC with 6 chanr
it , Four it timers with capture/compare, Watchdog Timer,
£ Lpc23s7 10bit DAC, Four 32 il 4 Watchdog Ti
£1 Lpca3ss R KN I o

QK I Cancel Help

13. Click the No button to add the startup file to the project.

In your practical projects you should choose to add the startup file, as will be discussed
in a separate tutorial.
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14. Make a new file by clicking on the New Icon (you can make a new file by pressing Ctrl+N or
choosing New from the File menu, as well.)

F ™
ChUsers\Zomorrod\DesktophTemp\CurFirstProject\curFirstProject.uvproj - pVisiond E@lﬂ

| File | Edit View Project Flash Debug Peripherals Tools 5SVCS  Window  Help

D & @) & i | | ™ B m| == e | @ anore
) New (Ctri=N)_ T et EFEIN =

Proi Create an empty document

15. Press Ctrl+S to save the new file. (You can also save the file by choosing Save from the File
menu.)

— -

- e
ChUsers\Zomaorrod'\ Desktop\Temp\CurFirstProject\ourFirstProject.uvprej - |.|"u"i...[ ':'Ehl

File Edit “iew Project Flash Debug Peripherals Tools SVCS5 Window  Help

al= F1C I | |m oo M| = E E

16. Name the file as program.asm and save it in the OurFirstProject directory.

| C:\Users\Zomarr

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help

DEEH@| &2 @9 |@=|pmBnmRkESE§R® EEY AN ¢ e[ @) %

O | 8| Terget1 & &2

Project B [ Text1 - B > X
K Save As [F5C) ‘el
E-§3 Target 1 1 =

D Source Group 2

.+ OurFirstProject v | #9 | [ Search QurfirstProject o
EI®N ]I |

Organize v New folder == - (7]

-

457 Favorites i MName Date modified Type

B Desktop | ourFirstProject.plg T PLG File
& Downloads @] ourFirstProject TV -
T,

i Recent Places  |= || ourFirstProject_Target 1.dep TATAT

pVisiond Project
DEP File

4 Libraries
3 @ Documents
3 J’ Music
I [&=] Pictures
> B Videos

|>i@ Homegroup [ [T b

File name: prugram‘asm[ -

Save as type: | All Files (*.) vI

~ Hide Folders [ sae | [ conca |

< 1 +

Ee[@s] UF[0,.

-

. »

Simulation CAP NUM SCRL OVR| R /W

17. Type the following sample program in the file

Project a [] program.asm* - X
=% Project: ourFirstProj... 1 LREXL A SIMPLE PROGRAM,CODE, READONLY
[-fed Targetl 2 MOV R1,#0x05
3 MOV R2, $0x03
4 ADD R1,R1,R2
S HERE B HERE
6 END
7
Er.. | €Fe. {3F. (0,7 ]« ] C
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18. Add the program.asm file to the project. To do so:

a. Click on the + next to the Target 1 to expand the tree. Right click on Source Group 1
and choose Add Existing Files to Group.

Project 1B [ program.asm* —
= %% Project: ourfirstProject 1 LREL A _SIMPLE_PROGRAM, CODE, RERDONLY
a0 Targetl 2 MOV R1,#0x05
3 Source Groun 1 3 MOV R2, #0x03
,ﬁ\ Options for Group 'Source Group 1. Alt=F7

Add Mew Hem to Group "Source Group 1'...
Add Existing Files to Group 'Source Group 1'...

Remove Group ‘Source Group 1" and its Files
4 I

Er. 5. Rebuild all target files v
Build Output : Build Target F7 7 @
IManage Project Items... -

v | ShowInclude File Dependencies

4

Add Existing Files to current Praject Group Simulation

b. Then go to the OurFirstProject directory and choose Program.asm, press Add and
then Close.

r =
Add Files to Group "Source Group 1' M
Look in: I || QurFirstProject j L 0
Mame . Date modified Ty
|| program.asm VAT 0 A= A
1 | 1] k
File name: Ipn::glam Add I
Files of type: Iﬂsm Source file (5% *snc; =a%) ;I Close |
A
L =
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Building

19. To compile click on the Build icon or choose build target from the Project menu.

-
ChUsers\Zomorred\Desktop\TemphCurFirstProject\curFirstProject.uvproj - pVisiond

NDEdad| s @l | | ®

20. If the program is built successfully the following message appears:

Build Output

File Edit View Project Flash Debug Peripherals Tools SVCS

o] 8 e &b =

Window Help

= JE I

Code=1l6 RO-data=0 REW-data=0 ZI-data=0

Program Size:
0 Warning(s) .

" . \Objects\ourFirstProject.axf" - 0 Error(s),
Build Time Elapsed: 00:00:00

4

Simulation

Debugging and Tracing

21. To start debugging click on Start/Stop Debug Session icon or choose Start/Stop Debug

Session from the Debug menu. (or simply press Ctrl+F5)

- L g g T R e e >
stProject.uvproj - uVisiond

Tools SVCS Window Help

L

= = ) /| @ enoRgHander  [¢] 5 ¢ Y

22. If it starts tracing successfully, a cursor appears in front of the

s &|[E)

next instruction to be

executed.
Disassembly n
ED{JRDGDGDGD{J E3AQ01005 MOV El, #0x00000005 -
3: MoV B2, #0x03 |:|
O0=x00000004 E3AQ02003 MOV RZ2,#0x00000003 |
4: AT R1.R1.R? i
« [ b
J program.asm v X
[ 2| MOV R1,#0x05 -
2 MOV RZ,#0x03 |j
4 ADD R1,R1,ER2
5 HERE B HERE - |
4 | 0 | b
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23. Go to the Peripherals menu. It has tools for monitoring different peripherals. For now,
choose Port 2 from GPIO Fast Interface. It shows the registers of Port 2; you can see values

of registers while tracing the
Peripherals | Tools SVC5  Window  Help

program or change their values

by clicking on each bit. Core Peripherals P [# EINTO_IRQ
System Control Block (= 1
M

Clocking & Power Control FE

Flash Accelerator Module

Fin Connect Block

[ GPIO Fast Interface b Port 0
GPIC Interrupts » Port 1
UART H Port 2 |
CAN » Port 3
SFlInterface Port 4
55P Interface L4
2C Interface L4
Timer 3

Repetitive Interrupt Timer

Pulse Width Modulator L4
Motor Control Pulse Width Modulator
CQuadrature Encoder Interface

Real Time Clock

Watchdog Timer

A/D Converter

D/A Converter

[ General Purpose Input/Output 2 (GPIO 2) - Fast Interface u1
“GPIO2 - . . : :
FIO2DIR: | |EH| | |E:d5| | |24i23| | |E:rt5| | |16|15| | IBIHI | |3 |?| | |Er|t5| | |ﬂ
FIOZMASK: |B00000000 T T T P T T I I I I T
FIOZSET |Be00000000 T T T T I T I I [T I rrrrrrrd
FIO2CLRBO0000000 T T T I I I I [T I rrrrrrrd
il | FIO2PIN:|ROODO3FFF P TTTT FTTTTITTIT ITRFFRFFRFE FRRRRRR
i Pins: [(x00003FFF Wi W v

- —— —— — " |
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24. To trace the program, use the Step Over button or click on Step Over from the Debug menu.
It executes the instructions of the program one after another. To trace the program, you can
use the Step button, as well. The difference between the Step Over and Step is in executing
functions. While Step goes into the function and executes its instructions one by one, Step
Over executes the function completely and goes to the instruction next to the function. To
see the difference between them, trace the program once with Step Over and then with
Step. When you are in the function and you want the function to be executed completely
you can use Step Out. In the case, the instructions of the function will be executed, it returns
from the function, and goes to the instruction which is next to the function call.

ChUsers\Zomorred\Desktop\ TemphCurFirstProjecticurFirstProject.uvproj - pVisiond

File Edit View Project Flash Debug Peripherals Tools SVCS  Window  Help

G @ v @ | | | = = |

% | B ¢ DREEDS-(O)E- -
Registers B Disassembly
{4} Step (F11) {} Step Over (F10) {'¥ Step Out (Ctrl+F11)

Step one line Step over the current line Step out of the current function

25. To exit from the debugging mode press Start/Stop Debug Session.
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